GoToWebinar® User Guide

Mobile Devices
GoToMeeting App for iPad, iPhone & iPod Touch FAQs
General Information
What is the GoToMeeting app for iPad, iPhone & iPod Touch?
GoToMeeting now offers attendees the flexibility to attend meetings and webinars directly from an Apple®
iPad, iPhone and iPod Touch. The free GoToMeeting app enables iPad, iPhone and iPod Touch
attendees to view online meeting content shared by a GoToMeeting organizer or presenter from a Mac®
or PC. Attendees are not required to have a GoToMeeting account to join a meeting or webinar.
To leave feedback about your GoToMeeting app experience, fill out the GoToMeeting Feedback form.
After each session, you can also tap the How was your GoToMeeting? button to leave your feedback.
What can I do with GoToMeeting on an iPad, iPhone or iPod Touch?
•
•
•
•
•
•
•
•

Attend online meetings or webinars free of charge.
Join sessions in seconds by tapping the Join link in your invitation email.
View the presenter's screen.
Connect to audio through your iPad, iPhone or iPod Touch's Internet connection or dial in by
phone.
Chat with everyone in the meeting, with only organizers or with individual attendees. (Chat isn't
supported for GoToWebinar at this time.)
Pinch with 2-fingers or double-tap to zoom.
Switch between portrait and landscape mode.
See who's talking and who's attending.

How much does the GoToMeeting app cost?
There is no cost for the GoToMeeting app. You can easily download the app from the App Store.
What are the mandatory system requirements to attend sessions from my iPad, iPhone or iPod
Touch?
•
•
•

Free GoToMeeting app from the App Store.
iOS 4.2 or later.
iPad 1 or newer, iPhone 3G or newer or iPod Touch 3rd generation or newer.

Can I join a GoToMeeting with HDFaces session from an iPad, iPhone or iPod Touch?
Yes. You can join HDFaces meetings as an attendee, but you'll be unable to view or share webcams and
show your screen (if you're given presenter controls) at this time.
Are there any additional fees for using the GoToMeeting app?
The app is free, and there's no charge for attending meetings or webinars. However, you are responsible
for any long-distance charges associated with dialing in to sessions by phone. There are no long-distance
charges for using audio over your iPad, iPhone or iPod Touch's built-in mic & speakers (VoIP), but you'll
be responsible for any data charges that may be incurred.
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How do I join a session from an iPad, iPhone or iPod Touch?
If you know the 9-digit Meeting or Webinar ID, you can join the session by simply opening the
GoToMeeting app and entering your name and the Meeting or Webinar ID (webinar attendees must also
enter their email). If you already have the GoToMeeting app installed, you can also join a session by
tapping the Join link in your GoToMeeting or GoToWebinar invitation email, which will automatically
launch you into session.
Where can I download the GoToMeeting app?
You can download the free GoToMeeting app from the App Store.
Can I host a meeting or webinar from my iPad, iPhone or iPod Touch? Can I show my screen if I'm
given presenter controls?
You can only join sessions as an attendee and cannot show your screen from your iPad, iPhone or iPod
Touch at this time.
Can I join a webinar as a panelist?
No, you cannot join a webinar as a panelist on an iPad, iPhone or iPod Touch.
How does attending a meeting or webinar on an iPad, iPhone or iPod Touch compare with the
experience on a PC or Mac?
Just as on a PC or Mac, you can view the presenter's screen, see who's attending and who's talking.
However, some features are not yet available on the iPad, iPhone and iPod Touch, including drawing
tools, presenter controls, keyboard and mouse controls and starting or scheduling sessions.
How can I change the view or zoom into the presenter's screen?
You can view the presenter's screen in both portrait and landscape mode. You can also double-tap
anywhere on the GoToMeeting Viewer to change the display to Fill Screen mode. Double-tap a second
time to zoom in to 100% mode. Double-tap a third time to return to the default view – Entire Screen mode.
You can also pinch or expand with 2 fingers, and pan to different parts of the presenter's screen by
dragging 1 finger across the GoToMeeting Viewer.
Can I chat with other meeting participants?
Yes, you can tap Chat in the toolbar to instantly send and receive messages to everyone in the meeting,
to only the organizer(s) or to individual attendees. You can toggle between meeting participant names in
the Attendee List to read and send messages. Chat is currently not supported on GoToWebinar at this
time.
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Can I ask questions, raise my hand or answer polls during a webinar?
No. At this time, asking questions (Q & A), raising your hand and answering polls are not supported
GoToWebinar features on the GoToMeeting app. If a GoToWebinar organizer sends a chat or question to
everyone in the webinar, iOS attendees will not be able to reply or send a response.
What version of GoToMeeting is required to host an iPad, iPhone or iPod Touch attendee?
An iPad, iPhone and iPod Touch attendee can only attend meetings or webinars that are hosted on
GoToMeeting 4.8 or later. On a PC, the organizer can check their version and build number while in
session by clicking the Help menu and selecting About GoToMeeting or About GoToWebinar. The
in the system tray and select About. On a Mac,
organizer on a PC can also right-click the daisy icon
the organizer can click GoToMeeting in the toolbar and select About GoToMeeting.
Can I attend meetings that are password protected?
Yes, you can join password-protected meetings as long as you have the password, which is included in
your GoToMeeting invitation email. All meetings are fully secured with end-to-end 128-bit AES encryption.
Is the GoToMeeting app available on any other mobile device?
The GoToMeeting app is also available on Android smartphones and tablets.
Can I attend a GoToWebinar session from an iPad, iPhone or iPod Touch?
Yes! Simply use the GoToMeeting app to attend webinars from your iPad, iPhone or iPod touch.
Can I attend a GoToTraining session from an iPad, iPhone or iPod Touch?
No. You can only join GoToMeeting and GoToWebinar sessions as an attendee at this time.

Audio
Can I connect to audio from the GoToMeeting app?
If the organizer provides both mic and speakers (VoIP) and conference call numbers, you will
automatically connect to mic and speakers over your iPad, iPhone or iPod Touch’s Internet connection
(WiFi or 3G) once you join.. The audio quality on your iPhone depends on the quality and bandwidth
available on the WiFi or 3G network that you're connected to. For best results, you should make sure you
have nothing else running that might use up bandwidth. WiFi connection is highly recommended.
If the organizer only provides a conference call number, or if you prefer to dial in by phone, iPad
at the top right of the screen, tap Audio Settings and then
attendees can tap the Settings button
Telephone to access the conference call information.
iPhone attendees can go to the Meeting Information screen and tap a U.S. phone number to
automatically connect to the audio conference. With a single tap, the conference call number, access
code and Audio PIN are automatically dialed.
If you have an iPhone 4 or 4S on a network that does not allow simultaneous voice and data sharing
(CDMA), you won’t be able to connect to GoToMeeting and dial in on your iPhone at the same time. To
connect to audio, you should use your iPhone’s Internet connection (WiFi or 3G) or dial in with a different
device.
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Can I mute/unmute attendees using VoIP or dialing in by phone on iOS devices?
Yes, if the attendee is connected to VoIP, you can mute/unmute them to allow them to speak. If the
attendee is dialed in by phone, you can mute/unmute them only if the they have entered the Audio PIN,
which they can access in-session from Settings.
How do I dial in to the audio conference by phone?
If the organizer provides a U.S. phone number, you can go to the Meeting Information screen in-session
and tap the telephone number to automatically connect to the audio conference from your iPhone.
International telephone numbers do not have the single tap auto-dialing capability at this time. You can
still use the Phone app on your iPhone to enter international telephone numbers manually and dial in to
the audio conference.
Why can't I switch from phone to mic & speakers (VoIP)?
Once you dial in to the audio conference, mic and speakers (VoIP) is disabled for the remainder of the
session. If you want to switch back to VoIP, you will need to leave the session and rejoin.
Why can't I connect to GoToMeeting and dial in on my iPhone?
If you have an iPhone 4 or 4S on anetwork that does not allow simultaneous voice and data over
(CDMA), you won't be able to connect to GoToMeeting and dial in on your iPhone at the same time. To
connect to audio, you should use your iPhone's built-in mic and speakers (VoIP) or dial in with a different
device.
If the organizer only provides a conference call number as the audio option and you try to dial in to the
audio conference from a CDMA network without having a WiFi connection, you'll see a dialog notifying
you that your device does not support simultaneous voice and data sharing. Once you tap the Dial button
on the Join the Audio Conference dialog, you'll lose access to screen sharing.
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What audio options does the GoToMeeting app support?
•
•
•
•

iPad, iPhone or iPod Touch's built-in mic and speakers (VoIP).
iPad, iPhone or iPod Touch's built-in mic along with external headphones connected via the 3.5mm stereo headphone jack.
Headset connected via the 3.5-mm stereo headphone jack.
Bluetooth Hands Free devices.

For optimal audio quality, we recommend using a headset.
Will I have access to all of the session's conference call numbers?
Any conference call numbers provided by the organizer are available to an iPad attendee. iPhone
attendees who prefer to dial in by phone can access the conference call number(s) (if provided by the
organizer) in the GoToMeeting or GoToWebinar invitation email or Meeting Information screen.

Troubleshooting
Why do I have to enable cookies to join a session? How do I enable cookies on Safari?
If your iPad, iPhone or iPod Touch is running iOS 5 or higher, cookies are disabled on Safari by default.
You must first change your settings to enable cookies before you can join a meeting or webinar. To
enable cookies on Safari, go to Settings > Safari > Accept Cookies > Always or From Visited. Then
tap the Join link in your GoToMeeting or GoToWebinar invitation email to join the session.
I enabled cookies on Safari but still can't join the session. What should I do?
Try clearing your history, cookies and data by going to Settings > Safari > Clear History/Clear Cookies
and Data. Then tap the Join link again in your GoToMeeting or GoToWebinar invitation email to join the
session.
If you're still having problems joining, try forcing the GoToMeeting app to close:
1. Double-click the Home button to bring up the multi-tasking bar.
2. Press and hold the GoToMeeting app until the icon starts to wiggle.
3. Tap the minus symbol above the GoToMeeting app to close it.
4. Tap the Home button or anywhere above the multi-tasking bar to exit.
5. Then tap the Join link in your GoToMeeting or GoToWebinar invitation email to join. If you know the
9-digit Meeting or Webinar ID, you can also open the app and manually enter it.
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GoToMeeting App for Android FAQs
General Information
Can I use the GoToMeeting app for Android on my Android device?
Yes. If you’re running Android 2.2 or higher, you can install the GoToMeeting app from the Google Play
Store to join meetings and webinars as an attendee. We recommend using devices with a 1Ghz
processor or higher for optimal performance.
How can I download the GoToMeeting app?
You can download the GoToMeetng app from the Google Play Store by signing in to your Google account
linked with your Android device and searching for the GoToMeeting app to install it. If you don’t see an
Install button, you may not be running Android 2.2 or higher – the minimum system requirement needed
to install the GoToMeeting app.
You can also download the GoToMeeting app from the Amazon Appstore (only available in the U.S.),
which lets you instantly download the GoToMeeting app to an Android device.
If you have the GoToMeeting app pre-loaded onto your device, you’ll need to first upgrade to the latest
and then select the Upgrade
version of GoToMeeting. To upgrade, select the GoToMeeting daisy icon
button to install the most recent version of the app.

If I have a Motorola Android-based device that doesn’t have the Google Play app, can I still
download the GoToMeeting app?
Yes. Attendees using Motorola Android-based devices in China can now download the GoToMeeting app
from SHOP4APPS™ – Motorola’s preinstalled Android application storefront. The GoToMeeting app is
not yet localized in Chinese, but it is available in English, German, French, Spanish and Italian.
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Why can I see the GoToMeeting app in the Google Play Store but can’t download it?
Your device may not be running Android 2.2 or higher (the minimum system requirement needed to install
the GoToMeeting app). If your device is running 528 MHz CPU, you may not see the Install button to
download the GoToMeeting app.
What are the minimum system requirements for joining a GoToMeeting or GoToWebinar session
from my Android device?
•
•
•
•

Android 2.2 or higher
1 Ghz CPU or higher recommended
WiFi or 3G connection (WiFi recommended)
Free GoToMeeting App

Note: Attendees on devices that use CDMA and do not allow simultaneous data and voice sharing must be connected to the
Internet from a WiFi network to dial in using the same device they use to join the meeting. Otherwise, they will be disconnected from
GoToMeeting. Attendees on devices that use GSM can simultaneously share data and voice seamlessly.

•

For the best audio experience, a headset recommended.

Can I host meetings or webinars from the GoToMeeting app?
Unfortunately, the GoToMeeting app for Android is only designed to support attendees who want to join
meetings and webinars. Attendees who join sessions from their Android device cannot be given
Presenter Controls at this time. Attendees do not have to have a GoToMeeting account to use the
GoToMeeting app.
Can I join a GoToWebinar session as an attendee on my Android smartphone or tablet?
Yes! Simply use the GoToMeeting app to join a webinar as an attendee. You can select the Join URL
from your GoToWebinar invitation email, or you can enter the Webinar ID (into the Meeting ID field) to
join. If you haven't yet registered for the webinar, you'll be prompted to register and fill out the required
information before you can join the session.
Can I join or host a GoToTraining or GoToMeeting Global session from the GoToMeeting app?
No. The GoToMeeting app is only designed for attendees to join meetings and webinars at this time.
Do I need a GoToMeeting or GoToWebinar account to join a session from my Android device?
No. As long as you’re running Android 2.2 or higher, you can install the GoToMeeting app from the
Google Play Store free of charge and join meetings and webinars from your device.
What are some of the unsupported GoToWebinar staff features?
•

Starting or joining a webinar as an organizer
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•
•
•

Joining a webinar from a panelist invitation email
Presenting as a panelist or organizer
Screen Sharing

What are some of the unsupported GoToWebinar attendee features?
•
•
•
•
•

Submitting responses to Polls (attendees can only see Polls)
Participating in Q & A
Sending and receiving chats
Raising hands
Screen Sharing or presenting

Can I multi-task and use other apps on my Android device while attending a session?
Yes. During a session, you can put the GoToMeeting app into background mode by pressing the Home
button on your device to simultaneously use other apps without disconnecting from the meeting.
To re-open the GoToMeeting app, you can do any of the following:
•
•
•

from the Android app menu.
Select the GoToMeeting daisy icon
Open the Notifications tab and select GoToMeeting.
Hold down the Home button on your device until the Recent Apps screen appears. Select the
GoToMeeting daisy icon .

Can I use a Bluetooth device for a meeting or webinar?
The GoToMeeting app for Android does not officially support Bluetooth devices. However, if you have an
A2DP (Advanced Audio Distribution Profile) device, you may be able to listen to the audio during a
meeting or webinar, but you probably won't be able to speak. If you can stream music from your Bluetooth
device, then you most likely have an A2DP profile that may let you listen to audio during a meeting or
webinar – but it's not guaranteed.
Check your device's manufacturer to see if it supports an A2DP profile.
What languages does the GoToMeeting app for Android support?
The GoToMeeting app for Android is supported in English, German, French, Spanish and Italian. If you
set your device’s default language to one of the supported languages, the GoToMeeting app appears in
your selected language.

Troubleshooting
Why can’t I connect to a meeting or webinar on the GoToMeeting app for Android?
The meeting organizer must be using GoToMeeting v4.8 or higher or GoToWebinar v2.8 or higher for
attendees to join sessions from Android devices. If the organizer is using an older version, you won’t be
able to use the GoToMeeting app; instead, you would need to join the meeting from a PC or Mac.
Attendees cannot join GoToTraining or GoToMeeting Global sessions from an Android device.
Why do I see an “Unable to Join the Meeting” error telling me that the Meeting ID is invalid?
If you manually entered the Meeting ID, double check to see that you typed it correctly.
Why do I have to enable cookies to join? How do I enable cookies on my browser?
If your browser is set to disable cookies, you must first enable cookies before you can join a session. To
enable cookies, go to your browser's settings, and select Accept Cookies. Then select the Join link in
your GoToMeeting or GoToWebinar invitation email to join.
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I prefer to dial in to audio by phone. Where can I find the Audio PIN?
The Audio PIN is not created until the organizer starts the session. You can access the Audio PIN once
the organizer arrives and you enter the session by selecting Settings from the View tab and then
selecting Meeting Information.
Why am I disconnected from GoToMeeting when I try dialing in from my device?
If you’re using a device that doesn’t allow simultaneous data and voice sharing (CDMA), you must
connect to the Internet from a WiFi network to dial in using the same device you use to join the meeting;
otherwise, you’ll be disconnected from GoToMeeting. If you aren’t connected to the Internet through WiFi,
you must use your device’s mic and speakers (VoIP) or dial in with a different device to connect to audio.
Why can’t I access the Meeting Information in my Settings before the meeting starts?
You have to wait until you enter the meeting before you can access the Meeting Information. Once the
organizer starts the meeting, you can access the Meeting Information by selecting the Settings button on
the View tab.
Why can't I register for a webinar from my Android device?
You may be using an Android device that is not fully compatible with GoToWebinar. Try registering for the
webinar from a supported computer or tablet.
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FAQs
Audio FAQs
I can't hear other callers
•
•
•

in the Attendee List of your Control Panel to un-mute an attendee.
Click the audio icon
Telephone users: Hang up and dial back in.
VoIP users:
a. Test your Speakers setup. Click Audio Setup in the Audio pane to select the correct device.
Mac users: Click the speaker icon in the Audio pane to select the correct device.
b. Check the volume setting in Audio Setup. Under Speakers Setup, click Play Sound and
move the slider bar to the desired volume.

Other callers can't hear me
•
•
•
•

Start Broadcast: You must click Start Broadcast at the top of the Control Panel or *1 on your
telephone keypad to start the conference.
You can change your audio selection from the Audio pane if you scheduled your Webinar to offer
both VoIP and telephone.
Telephone users: Hang up and dial back in.
VoIP users:
a. Is the correct microphone device selected? Click Audio Setup in the Audio pane to select
the correct device. Mac users: Click the microphone icon in the Audio pane to select the
correct device.
b. If using a microphone: Does your microphone have a physical mute/un-mute button on it?
Check that your microphone is not muted.
c. If an attendee can't hear you, his or her speaker volume may be off or set too low.
d. Analog microphones are sometimes too quiet; we recommend using a USB headset or USB
desktop microphone instead.
e. If you are using a desktop microphone, avoid touching the microphone since it may cause a
reduction in the volume of your voice.
f. Speaking very loudly can affect the volume; try speaking at a lower level.
g. The speed of your Internet connection can affect one-way sound. For optimum performance
when using VoIP, we recommend a broadband Internet connection.
h. File sharing: Uploading a file while using GoToWebinar can sometimes affect VoIP sound
quality. It is recommended that you close all file sharing applications before you start your
Webinar.
i. Streaming music or video while using GoToWebinar can sometimes affect VoIP sound
quality. It is recommended that you close all streaming music or video before you start your
Webinar.

I hear static, beeping or a clicking sound
•

Electronic devices, such as Blackberries, can affect microphone and speaker devices. Move any
electronic handheld devices away from your microphone and speakers.

I'm experiencing echo, feedback or background noise
•

A USB headset is recommended. See VoIP Audio Device Recommendations.

•

Echo from an attendee: If you suspect echo from an attendee, check who is talking at the bottom
of the Audio pane and mute that attendee or ask the attendee to lower his or her speaker volume.
You can also click Mute All in the Audio pane.
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•

If you join your Webinar via telephone make sure the audio setting on your Control Panel is not set
to Use Mic & Speakers.

•

Built-in or external speakers can cause echo. We recommend reducing the speaker volume to a
low level.

•

Laptops with built-in microphones can pick up noise and cause echo. Using a built-in microphone
for your audio is not recommended. If you know how to turn off your laptop's built-in microphone,
turn it off for your presentation (check your laptop's owner manual).

•

Webcams with microphones can pick up additional noise and cause echo. Using a Webcam for
your audio is not recommended.

•

A Webinar is best presented from a quiet location.

•

If using a microphone, move the microphone closer to your voice and away from competing
sounds (e.g., computer fans).

•

Avoid moving or touching the microphone during your presentation.

Words are getting cut off or are being dropped
Dropped words, delay or robotic sound is often due to poor network performance, lack of memory or high
CPU usage.
•

Close all applications you are not using for your presentation.

•

VoIP users: A dial-up Internet connection can cause poor performance. For optimum performance
when using VoIP, we recommend a broadband Internet connection.

•

VoIP users: If the problem persists, switch to Telephone mode. Select Use Telephone in the Audio
pane and dial in to the Webinar.

I need to adjust my VoIP audio volume
•

Click Audio Setup in the Audio pane. Under Speakers Setup, move the slider bar to the desired
volume.

If the presenter is using telephone/VoIP can the attendees hear him on the other service?
Yes. The only difference is that in order to take over the presenter role via telephone, the user will be
asked to dial into a different number so he can become part of the presentation team and exit the
audience line.
I'm getting an error message
An audio device (speakers or headset) is necessary to join a Webinar using VoIP. When an audio device
such as microphone or speakers is not detected, some of the following errors may occur:
No Speakers Detected
An error message will appear if speakers (or headset) are
not present or are not connected properly, or if there is no
sound card installed in your computer. You will not hear
audio at this time and will not be heard in the conference.

•

Check that your speakers (or headset) are properly
connected and click Try Again in the Audio pane
of the Control Panel. See Audio Mode: Using VoIP.
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•

If you have the option to join the Webinar via telephone, you will automatically be switched to
Telephone mode. Dial in to the conference using the number and audio PIN provided in the Audio
pane of your Control Panel.

No Sound Detected
After the first minute of a session, GoToWebinar looks for microphone input from attendees who are
using a microphone, have speaking rights and are un-muted.
If no input is detected, you may get a Trying to speak? error message. This error may appear under the
following conditions:
•

You have not spoken or made any sound during the first minute of joining the Webinar, or

•

The microphone device was incorrectly selected. You can click the Audio Setup link if you are
trying to speak but can't be heard. See Audio Mode: Using VoIP.

No Microphone Detected
An error message will appear if a microphone (or headset) is not
present or is not connected properly. You will still be able to hear
the Webinar but will not be able to speak.
•

Check that your microphone (or headset) is properly
plugged in.

•

If you have the option to join the Webinar via telephone,
you can switch to Telephone mode. Then dial in to the
conference using the number and Audio PIN provided in
the Audio pane of your Control Panel.

Microphone Disconnected
An error message will appear if your microphone fails or is
unplugged after joining a Webinar. When this happens, you will no
longer hear audio nor be heard by others.
•

Check that your microphone is properly plugged in. If it is, test
your microphone device and click Try Again in the Audio
pane of the Control Panel. See Audio Mode: Using VoIP.

•

If you have the option to join the Webinar via telephone, you
can switch to Telephone mode. Then dial in to the conference
using the number and audio PIN provided in the Audio pane
of your Control Panel.
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Virtual Operating System (VMware, Parallels, etc.)
An error message will appear if you are attempting to join a Webinar using VoIP through a virtualized
operating system, such as VMware, Parallels, etc. In this
instance, to connect to audio, please choose one of the
following:
•

Rejoin the Webinar through a non-virtual operating
system.

•

If you have the option to join the Webinar via telephone,
you can switch to Telephone mode. Then dial in to the
conference using the number and audio PIN provided in
the Audio pane of your Control Panel

What are audio tips and best practices?
•
•
•
•
•

As with any Webinar, it is important to test your sound quality and audio settings before your live
event. In addition to testing your audio settings, it is recommended to start your Webinar in
Practice mode with other organizers or panelists to provide feedback on your voice quality.
If you plan to record your Webinar, be sure to test the Recording feature while in Practice mode.
It is a best practice to close all applications and documents you are not using for your presentation;
applications running in the background may use up your computer's bandwidth and affect network
performance.
It is a best practice to keep attendees muted during your presentation and un-mute individual
attendees as necessary.
Attendees who join the audio portion of your Webinar are joined muted by default. Up to 25
attendees can be un-muted at any one time (this is a combination of VoIP and phone attendees).
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Integrated Toll-Free FAQ
What it Integrated Toll-Free Audio Service?
Integrated Toll-Free Audio is an additional service that'll allow you to offer your GoToMeeting and
GoToWebinar attendees a toll-free option. With integrated toll-free you have the flexibility to schedule
your sessions with any combination of long distance, toll-free and VoIP audio.
How much does it cost to use the Integrated Toll-Free audio service?
Per-minute charges are based on your service contract, and minutes are calculated per participants. (For
instance, if three participants call in the session for 10 minutes using the toll-free option, you will have
used 30 minutes of your plan. Those who join by regular toll numbers are charged rates based on their
own long-distance provider. There are no additional charges for those who join a meeting or Webinar with
VoIP audio.
How am I billed for the toll-free service?
You will receive a separate monthly invoice from Citrix Online Audio, LLC for any toll-free minutes used
by you and your attendees.
How do I add the toll-free option to meetings/Webinars that I've already scheduled?
For any Webinar, meeting or recurring meeting that was scheduled prior to an account's toll-free
integration, the regular toll based conference numbers will automatically be changed if toll-free numbers
are added to an already existing meeting or Webinar. It is recommended that you resend the meeting
invitation or Webinar confirmation emails to participants so they have access to the new toll-free audio
information. Meeting IDs and URLs will stay the same, however, and the new toll-free number will be
provided to attendees in the waiting room, as well as on the Control Panel.
Will I use the same toll-free number for each meeting or Webinar?
No, as with existing meetings and Webinars, each session will have a unique toll-free number and access
code.
How do I schedule a meeting with Integrated Toll-Free?
To add a toll-free number to your meeting invitation, select the Edit Countries link in the Schedule a
Meeting window. Next, scroll to the bottom of the list of countries and select the option for U.S. and
Canada (toll-free).
Do you offer toll-free numbers for countries outside of the United States and Canada?
•
•

Individual GoToWebinar organizers have the option to add Integrated Toll-Free service for the
United States and Canada.
GoToMeeting Corporate accounts have the option to add Integrated Toll-Free service for the
following countries:
International Toll-Free Conference Numbers
(GoToMeeting Corporate)

Argentina

Hong Kong

New Zealand

Taiwan

Australia

Iceland

Panama

Thailand

Austria

India

Peru

Ukraine

Belarus

Indonesia

Philippines

United Kingdom
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International Toll-Free Conference Numbers
(GoToMeeting Corporate)
Belgium

Ireland

Poland

United States

Brazil

Israel

Portugal

Uruguay

Canada

Italy

Russia

Vietnam

China

Japan

Singapore

Czech Republic

Luxembourg

South Africa

Denmark

Malaysia

Spain

Finland

Mexico

Sweden

Can I purchase Integrated Toll-Free service outside the United States?
•
•

Individual GoToWebinar organizers based within the United States can purchase Integrated TollFree service.
GoToMeeting Corporate accounts can purchase Integrated Toll-Free service only if their billing
address is based in the United States, Australia, Canada or United Kingdom.

Is there anything different about recording a meeting/Webinar with Integrated Toll-Free?
Whether you or your attendees join with VoIP, toll or toll-free audio, you can easily and seamlessly record
all participants. From the Recording section of the Preferences window, simply select Use GoToMeeting
Audio Service. For more information about the Recording feature, please see Recording a Webinar.
How can I cancel Integrated Toll-Free?
If you'd like to cancel your Integrated Toll-Free service, please contact our 24/7 Global Customer Support.
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Mac OS X 10.7 Lion FAQs
The new Mac Lion OS promises to be a great upgrade for Mac customers. It includes over 250 new
features and many usability enhancements. We have been working closely with Apple and testing our
products with this new OS. There are a few known issues that our Mac customers should be aware of if
they upgrade to Lion.
If I purchase Mac OS X Lion, will GoToMeeting, GoToWebinar or GoToTraining work for me?
Yes, but you will need to make sure that (1) you're using GoToMeeting, GoToWebinar and/or
GoToTraining 4.8 or higher, and (2) you've installed a version of Java compatible with OS X Lion.
1. Checking the Version Number
If you have GoToWebinar or GoToTraining, remember that you will only see GoToMeeting on the
menu bar and desktop icon because the 3 products are all part of the same collaboration suite. To see
which GoToMeeting, GoToWebinar and/or GoToTraining version you're using on your Mac, do one of
the following:
• In session: Click GoToMeeting in the menu bar and select About GoToMeeting. The version
number will be listed in the window that pops up.
• Not in session: Hover your mouse pointer over the GoToMeeting (
to see a pop-up message listing which version you're using.

) daisy icon in your dock

If you are not using GoToMeeting, GoToWebinar or GoToTraining 4.8 or higher, you will still be able
to host meetings but will not be able to share your screen. To upgrade to the newest version, contact
your account manager (if you're on a corporate account) or call our toll-free 24/7 support line and
request to be upgraded.
2. Installing Java
GoToMeeting, GoToWebinar and GoToTraining require Java to be installed in order to host or join
sessions; without it, the GoToMeeting, GoToWebinar and GoToTraining applications cannot launch.
Since OS X Lion does not include Java, you will need to download and install a version of Java
compatible with OS X Lion (this is a one-time download of 150 MB). See Java is not installed in Mac
Lion. Do I need it? below for information on downloading Java.
Can I host a GoToMeeting, GoToWebinar or GoToTraining session from OS X Lion?
Yes. As long as you're using GoToMeeting, GoToWebinar and/or GoToTraining 4.8 or higher and have
Java installed, your current version will work fine. If you are using an older version, then you may be able
to start the session but you will not be able to share your screen. See If I purchase Mac OS X Lion, will
GoToMeeting, GoToWebinar or GoToTraining work for me? above for more information.
Can I attend a GoToMeeting, GoToWebinar or GoToTraining session from OS X Lion?
Yes. As long as you have Java installed, you should have no trouble joining. However, if the organizer is
not using GoToMeeting, GoToWebinar or GoToTraining 4.8 or higher and makes you the presenter, you
will not be able to share your screen. See If I purchase OS X Lion, will GoToMeeting, GoToWebinar or
GoToTraining work for me? above for more information.
Java is not installed in OS X Lion. Do I need it?
Yes. GoToMeeting, GoToWebinar and GoToTraining require Java to be installed in order to launch the
application. Since OS X Lion does not include Java, you will need to download and install Java
compatible with OS X Lion (this is a one-time download of 150 MB). See the following instructions to
download Java:
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1. Try to start or join a session. A "Missing Plug-in" message will appear instead of the download
progress bar on the Download page. Click the Meeting Plug-In icon ( ) next to the message.

2. When the following pup-up message appears, click Install.

3. When the following License Agreement appears, click Agree.
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4. When the following Download Progress bar appears, Java will begin automatically downloading and
installing the necessary packages (150 MB).

5. After installation is complete, you will need to refresh the page or simply launch the meeting,
webinar or training session again. You will then be able to join or host GoToMeeting, GoToWebinar or
GoToTraining sessions from Mac OS X Lion without being asked to download Java again.

What are the known issues with using GoToMeeting, GoToWebinar and/or GoToTraining on OS X
Lion?
If you do not have GoToMeeting, GoToWebinar and/or GoToTraining 4.8 or higher and are using OS X
Lion, then you will not be able to share your screen as an organizer or attendee (if you are made the
presenter).
Contact Us
Should you have any questions about using GoToMeeting, GoToWebinar or GoToTraining with the new
Mac Lion OS, please feel free to contact your account manager or call our toll-free 24/7 support line.
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Pre-Webinar FAQs
What time zone should I use when scheduling a Webinar?
When scheduling a Webinar, we recommend you use the time zone where the organizer is located. The
time zone can be set as a preference on the My Account page. On the Registration page, registrants will
see a Show time in my time zone link to help them convert times to their own locales.
To further clarify the time zones for your registrants/attendees, you can outline each time zone-based
start time in the Description section when scheduling your Webinar. This information will appear in both
the invitation email and the Webinar confirmation email. The Webinar confirmation email also provides a
link to add the Webinar to an Outlook calendar, which will automatically adjust it to the attendee's time
zone.
Can my co-organizer start the session if I am not available at the time of the scheduled Webinar?
On GoToMeeting Corporate plans, any organizer whom you have pre-specified before the start of your
Webinar can start the session. On GoToWebinar plans, you must start the Webinar; however, you can
promote someone else to organizer, leave the session, and allow the other organizer to manage the rest
of the event for you.
How do I invite people to register?
There are several ways to invite people to register for your Webinar. Once you have finished scheduling a
Webinar, an invitation email is sent to you.
•

You can forward the invitation email to all prospective attendees, just like forwarding any other
email.

Note: If the invitation is being sent to people outside of your organization, we recommend that you blind copy everyone on your
invitation list out of respect for their privacy.

•
•

You can place the invitation onto a Web site or company intranet:
o Save the invitation email as an HTML file.
o Incorporate the HTML code into the code of your Web site or company intranet.
A Registration Web link is provided for each scheduled Webinar. On the My Webinars page, click
the expansion button next to a Webinar date. The Registration Web link can be included in an
email or online newsletter or incorporated into the HTML code of a Web site or company intranet.

How do I make registration available on my Web site?
•
•

You can save the invitation email as an HTML file, then incorporate the HTML code into the code
of a Web site or company intranet.
A Registration Web link is provided for each scheduled Webinar. On the My Webinars page, click
the expansion button next to a Webinar date. The Registration Web link can be included in the
HTML code of your Web site or company intranet.

Can I create a calendar with all of my scheduled Webinars from which people can register?
Follow these simple steps to create a calendar and centralize your GoToWebinar registration:
1.
2.
3.

Create and code your calendar/registration web page and include the Webinar titles, dates and
times.
Schedule all of the Webinars you wish to include on your calendar. (Tip: Use the Schedule Similar
Webinar function.)
Copy the registration links for your scheduled Webinars and paste them into the HTML code of
your calendar/registration web page.

For additional instructions, see the GoToWebinar Hosting Webinar Registration QuickRef Guide.
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My attendees already register through my web site. Is there a way I can dump that information into
your Webinar registration?
You can manually register your attendees by clicking the Webinar session registration link:
1.
2.
3.

Log in to your account.
Click the expansion button next to the Webinar date for which you want to manually register
attendees.
Click Registration Web Link.

How can I bill the Webinar to my attendees?
If you would like to require participants to pay to attend your Webinar, you can customize your
Registration Form so that:
•
•

Registrants are redirected to a Web page of your choice where they can enter payment
information.
Registrants receive the Webinar confirmation email only after they have been approved by you
(allowing you to suspend confirmation until payment has been received).

When customizing the Registration Form:
1.

2.

In the After Registering section, select Upon Approval. Once you receive payment from a
registrant, you can approve that person to receive the Webinar confirmation email. See
Registration Tracking.
In the Redirect registrants to field, type a URL to redirect your registrants to a Web page where
they can provide you with payment information.

How can I view scheduled Webinars?
icon in the system tray or double-click the
To see what meetings you have scheduled, right-click the
GoToWebinar Suite icon on a Mac and select My Webinars. After your login email address is verified,
you will see the list of scheduled meetings.
You can also log in to www.gotowebinar.com and view your scheduled meetings.
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In-Session FAQs
Can I host a Webinar and join via VoIP using my XenApp server?
GoToWebinar Total Audio Service is not supported on the XenApp server with a server install. If you want
to join a Webinar using Mic & Speakers, join via your local computer.
Is there a way for me to see what my attendees see during a Webinar?
When presenting, the Audience View pane gives presenters a view of what the audience is seeing. In
your Control Panel, select View, then Audience View. (This feature is not yet available for Mac users.)
How do I allow attendees to show their screens during a Webinar?
If you would like an attendee to present during a Webinar, go to the Attendee List, right-click the
attendee's name and select Make Presenter. Note that once you promote an attendee to presenter, he or
she is a panelist for the remainder of the Webinar.
I don't want to have to forward my questions to the panelist. Is there a way for panelists to see
questions and answers?
All organizers can view the Question and Answer pane. Therefore, you can promote a panelist to
organizer and he or she will be able to view and manage Question and Answer. Note that once you
promote a panelist to organizer, he or she is an organizer for the remainder of the Webinar.
How do all organizers see the poll questions? I want my co-organizer to launch the poll but I want
to read it.
When a poll is launched, it will appear in the Control Panel of the person presenting and in the Viewer
window of all attendees (including other organizers and panelists). Therefore, if you are presenting,
another organizer can launch the poll and you will be able to view and respond to the poll in your Control
Panel.

Recording FAQs
How can I record the audio from the conference call?
See Recording a Webinar.
Can I edit a recording?
When selecting your recording preferences, choose the Windows Media Player format. In this format you
can edit your Webinar recording using most video editing software.
Why does the playback only display a blank screen?
To avoid a recorded Webinar with a blank screen, please ensure the presenter initiates some type of
screen action (such as advancing a presentation slide) after clicking the Start Recording button. If
recording begins before the presenter shares his or her screen and there is no screen action, then the
playback will only show a blank screen with the audio.
How do I replace an archived Webinar recording?
Log in to your account and select Webinar History. Find the title of the Webinar for which you want to
replace an archived recording. At Recorded Webinar, click Manage. On the Manage Webinar page, click
Replace Recording and follow the prompts.
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